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1 Introduction 

1.1 Presentation of the Tutorial 

This training exercise will guide you through the creation of hydrological models using 

MIKE 11 Rainfall-Runoff (RR) module. This add-on module is part of the MIKE 11 River 

modelling package, and may be used in combination with the Hydrodynamic (HD) 

module. 

 

MIKE 11 Rainfall-Runoff module offers a large range of hydrological models. With this 

tutorial, you will learn how to use two of the most widely used models, that is to say the 

NAM and UHM models. 

 

In Section 2, you will first learn how to build a NAM model, which is a conceptual and 

lumped model. It is mainly used on applications requiring long-term modelling. In this 

exercise you will see how to use MIKE 11’s facilities to calibrate the model, and then how 

to insert the runoff results from the Rainfall-Runoff model into a Hydrodynamic model. 

 

In Section 3, you will then learn how to build a hydrological model using the UHM method. 

UHM is the ‘Unit Hydrograph’ method, and is used for single event modelling. It may use 

various mathematical formulations for both routing and loss models. In this exercise, you 

will see how to set up a UHM model using SCS formulas. 

 

1.2 Data for the Exercises 

The data for the exercises are found in the “Handout_RR.zip” file and include: 

 

• A ‘RR’ folder containing a topographical description of the catchment as well as 

various input time series (rainfall, evaporation, discharge and temperature) 

• A ‘HD+RR’ folder containing an existing Hydrodynamic model. 
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2 Setting Up a NAM Model 

2.1 MIKE Zero Project 

The first step in building a new model is to create a MIKE Zero Project that will allow you 

to easily manage your modelling files under the MIKE Zero environment. 

 

Start MIKE Zero. From the MIKE Zero window select File > New > Project from 

template…  

 
1. In the Project Type list, select the General Project Type, and in the Templates list, 

select the General item. Change the location of the project to your training exercise 
folder. 

 

 
 
2. Fill in the Project Name (Sesup_NAM, for example) and the Client Name as indicated 

in the dialog and then click the ‘OK’ button to create the project folder. The folder 
structure of the selected project template is listed under the Project Explorer panel on 
the right-hand side of the MIKE Zero window. This panel provides you with an easily 
accessible overview of the project and the files associated with the project. 

3. It is a good idea to copy all the input data for the exercises under the relevant folders. 
For this exercise, we have to copy the Elevation_data.csv file in the ‘External Data’ 
folder, and all the times series (with *.dfs0 file extension) in the ‘Model Inputs’ folder. 
You can do that by right clicking on the folders and choosing ‘Add existing files’ and 
then browse to the files provided for this exercise. You will be prompted to choose 
between creating a shortcut and making a copy of the files: for this exercise we will 
make a copy. Alternatively, you can simply copy all exercise data to these folders in 
Windows Explorer. 
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4. Feel free to explore more options available from the Project Explorer, but also File 

Explorer, Tool Explorer, etc. 
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2.2 Basic NAM Simulation 

2.2.1 Getting started 

We will define the catchment model of Sesupe river using a NAM Rainfall-Runoff model. 

The calculated runoff will later be inserted in the provided Hydrodynamic model, which is 

illustrated below. The river Sesupe flows from South to North and has several tributaries.  

 

 
 

The first task is to start the MIKE Zero interface and to create a new MIKE 11 simulation 

file.  

 

Select Rainfall-Runoff model and save the MIKE 11 simulation file under the Project 

Model folder. Give it a meaningful name like ‘Sesupe_NAM.sim11’. 

 

Then create a new Rainfall-Runoff parameter file, and save it in the same folder. Give it a 

name like ‘NAM_parameters.rr11’. Finally, browse to this file in the Input tab of the 

simulation file. 

 

2.2.2 Catchment definition 

In the Rainfall-Runoff parameter file, define a new catchment. This catchment is called 

Sesupe, and has an 8 750 km² area. 
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Navigate through the various NAM tabs, but leave parameters untouched for now. We will 

indeed keep the default values for all parameters for the first simulation. 

 

Before running a simulation, we have to define input data. For a NAM simulation, the 

mandatory input data are rainfall and evaporation data. 

 

All input data for a Rainfall-Runoff simulation are defined in the Timeseries tab. On this 

page, we will use two time series to define the rainfall, and define weighting factors for 

each of them. First, activate the ‘Weighted timeseries’ option in the upper table and then 

load the time series called Observed_precipitation_1.dfs0 and 

Observed_precipitation_2.dfs0 in the Mean Area Weighting table. Finally, define the 

weighting factors to 40% and 60%, respectively. 

 

Evaporation data will be defined by a single time series. This time series has hence to be 

selected in the upper table. Use the file named Observed_evaporation.dfs0. The resulting 

page is illustrated thereafter. 
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Note that rainfall time series must be of ‘Step accumulated’ type. 

 

Don’t forget to save the file after making these changes. 

 

2.2.3 Simulation parameters 

In the Simulation tab of the simulation file, define the calculation time step to 1 hour, and 

simulation period from 01/06/1997 07:00:00 to 01/12/2001 00:00:00. 

 

Note that the time step is here defined to be consistent with the time step used for the 

input rainfall time series. Indeed, this allows taking full advantage of all observed data, 

whereas using a bigger calculation time step would not use all observed data. It is 

however not mandatory to use exactly the same time step for calculation as for input time 

series. 

 

In the Results tab, also provide a name for your result file. You don’t need to provide a full 

path neither to define the file extension. 

 

Then you can run the simulation, by pressing the ‘Start’ button on the Start page. The 

result file is saved in the ‘Result’ folder, and you can access it from the Project Explorer. 
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2.2.4 Analyse the base simulation results in MIKE View 

You can open MIKE View from Start > MIKE by DHI 2011 > MIKE View > MIKE View. 

MIKE View is a program used to load results in *.res11 format. 

 

For a Rainfall-Runoff result file, you can use MIKE View to display time series for 

calculated runoff and net rainfall. When a time series is displayed, MIKE View offers a 

range of options in the contextual menu, which you access by right-clicking the mouse 

button. You can for example: 

• Add multiple time series (including external ones) to one time series Plot 

• Show values (can be used to copy data into Excel) 

• Export images 

• Change display settings. 

Open your result file, and use the ‘Select gridpoint’ icon to plot the ‘Total runoff’ item. 

 

Then right-click on this plot and select ‘External TS…’ to load the discharge time series 

measured at the outlet of the catchment. These data are provided in the time series 

named Observed_discharge.dfs0. 

 

 
 

Calculated peak discharges are much higher than observed data. Hence, the next step 

will be to calibrate the model on the observed discharge data. 
 

2.3 Automatic calibration of parameters 

2.3.1 Calibration settings 

Calibration of the hydrological model may be done by adjusting the various parameters 

manually, one by one. However, in this case we will see how to use the auto-calibration 

feature, which can quickly set appropriate values to the various parameters 

simultaneously. 

 

First activate the feature on the Autocalibration tab. You can then select the parameters to 

be included in the calibration process: in this case we will keep all parameters included. 

 



Setting Up a NAM Model  

 9 

In the ‘Objective Function’ frame, you need to select on which criteria you want to 

calibrate the model. Assuming that we need the model to be calibrated on the overall 

observed data, keep the default functions: Overall Water Balance and Overall Root Mean 

Square Error. 

 

Initial months of the simulations should also be excluded from the calibration process, as 

the results on this period will depend more on the initial conditions rather than on the 

parameters values, and hence may degrade the quality of the calibration. You can for 

example exclude the four initial months. 

 

 
 

The auto-calibration feature will also need to use observed discharge data. Thus, define 

the associated time series in the Timeseries tab. 

 

Finally, you can tick the ‘Calibration plot’ box in the Catchment tab, in order to export a 

comparison of observed and calculated data. Then save and close the file. 

 

Change the name for the new result file, and run the simulation. 
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2.3.2 Analyse the calibration results 

Open the new results in MIKE View and compare the new calibrated results with 

observed discharge. 

 

You can also compare with the previous results. To do so, first load the previous result file 

from File \ Add… menu. Then right-click on the plot and select ‘Add TS…’ to select the 

Total runoff item from this previous result file.  

 

You can also check the calibration quality with the calibration plot which has been saved 

in the ‘RRCalibration’ subfolder. Simply open the file with extension *.plc, which provides 

the comparison between observed and simulated runoff time series, as well as 

accumulated volumes. 

 

Note that in order to get the new values for calibrated parameters, and before running a 

new simulation, you need to close and re-open the Rainfall-Runoff parameter file. 

 

2.3.3 Improve calibration 

Initial conditions 

From the previous result, you can see that results are not satisfying on the first months, 

due to inappropriate initial conditions. 

 

Hence, adjust the parameters in the Initial Conditions tab of the Rainfall-Runoff file, and 

try to find a set of values which gives results fitting the observed data. Rename the result 

file before each new simulation, in order to be able to compare with previous results. 

 

Which of the parameters are important for initial conditions in this case? 

 

Lower base flow 

In case the discharge depends on long term variation, with long response time, you can 

include a lower reservoir in the Ground Water tab. This additional reservoir will take these 

low variations into account. 

 

Remember to add associated parameters to the list of auto-calibrated parameters. Also 

note that you can define an initial condition for this lower reservoir. 

 

Again, rename the result file before each new simulation to be able to compare with 

previous results. 

 

Number of iterations 

Try to increase the number of iterations in the Autocalibration tab. Does it improve the 

results? 

 

Remark on auto-calibration 

Auto-calibration should be run on several years of observed data (in the range of 5-10 

years or more) in order to provide a robust and accurate calibration. 
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2.3.4 Calibration on high flow conditions 

We now assume that the purpose of the model is to reproduce flood events. 

 

Hence, make the necessary changes to the model setup to calibrate on high flow 

conditions only. 

 

Compare with the previous results. 

 

2.4 Adding basic snow melt simulation 

We’re now going to use a simple degree-day formula to take snow melt into account. 

 

Start by deactivating auto-calibration and generation of Calibration Plot. Then activate the 

Snow Melt feature by ticking the associated option. Keep the default degree-day 

coefficient and base temperature. 

 

For this setup to run, you need to provide input temperature time series. We will use in 

that case data from three different measurement stations, which require to use again the 

weighting possibility offered in the timeseries tab. Use the time series and associated 

weighted factors provided in the table below. 

 

Time series 
Observed_ 

temperature_1.dfs0 

Observed_ 

temperature_2.dfs0 

Observed_ 

temperature_3.dfs0 

Combination # 1 0.19 0.73 0.08 

Combination # 2 -1 0.83 0.17 

Combination # 3 0.55 -1 0.45 

 

Weighting factor ‘-1’ corresponds to a gap in the corresponding time series. Hence, 

combinations 2 and 3 are used whenever a gad is identified in time series 

Observed_temperature_1.dfs0 or Observed_temperature_2.dfs0, respectively. 

 

Rename the result file and run the simulation. 

 

Compare the new results with results without snow melt. You can add the weighted 

temperature time series, which has been created while launching the simulation, in MIKE 

View for a better understanding. 
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2.5 Adding advanced snow melt simulation 

Snow melt is highly dependent on topography, due to vertical variations of temperature. In 

order to best take this into account, we will now divide the catchment into sub-areas, and 

define a specific elevation for each of them. NAM will therefore compute temperature 

corrections and snow melt for each subarea, separately. 

 

To activate this option, tick the box in the ‘Elevation Zones’ frame. Then press ‘Edit 

Zones…’ and define seven elevation zones. Copy and paste ‘Elevation’ and ‘Area’ data 

from the Elevation_data.csv file. 

 

Define the reference level for temperature station to 595 m. Then activate the wet- and 

dry temperature lapse rate, and calculate the associated corrections by pressing the 

‘Calculate’ buttons. 
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Keep “Max water retained in snow” and “Correction of precipitation” unchanged. 

 

Run the simulation and compare with previous results. 

 

If time permits, you can try additional features in order to further optimize the calibration. 

You can e.g. activate the ‘Rainfall degree-day coefficient’ option, which is to be included 

when the melting effect from the advective heat transferred to the snow pack by rainfall is 

significant. See whether this additional option improves the results or not. 

 

2.6 Inserting runoff results into HD simulations 

2.6.1 Simultaneous RR and HD simulations 

Assuming we are now satisfied with the Rainfall-Runoff model calibration for the needs of 

the current exercise, we will now run the previous Rainfall-Runoff simulation 

simultaneously with a Hydrodynamic simulation. 

 

Open the provided Sesupe.mzp project file, related to the Hydrodynamic model. Navigate 

through the various setup files, in order to get acquainted with the HD model. 

 

Then copy and paste the Rainfall-Runoff parameter file in the ‘Model’ folder in the project 

tree. Also copy the associated input time series in the ‘Model Inputs’ subfolder. From the 

MIKE Zero Project Explorer, right-click on these newly copied files to insert them in the 

project. 

 

Open the Sesupe_base.sim11 file and add ‘Rainfall-Runoff’ module in the Models tab. 

Then browse the Rainfall-Runoff parameter file in the Input tab. 

 

It is then necessary to define the locations where the calculated runoff should be included 

in the Hydrodynamic model. To define these links, open the network file and open the 
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tabular view (menu View \ Tabluar View…). In the ‘Runoff/ groundwater links’ section, 

define the links as described in table below. 

 

 
Catchment 

name 

Catchment 

area 

Branch 

name 

Upstream 

chainage 

Downstream 

chainage 

Link # 1 Sesupe 2 225 Sesupe 0 58 750 

Link # 2 Sesupe 2 966 Sesupe 58 750 109 200 

Link # 3 Sesupe 3 559 Sesupe 109 200 154 075 

 

For each of these links, the discharge value inserted in the HD model is computed 

according to the ratio between the catchment area specified for the link and the total area 

of the catchment defined in the Rainfall-Runoff parameter file. 

 

The calculated discharge is then distributed on the branch between the two specified 

chainages. 

 

 
 

It is also possible to define point sources, by setting upstream and downstream chainages 

to the same values. 

 

Before running the simulation, make the following changes to the simulation file: 

• In the Simulation tab, set the ‘RR time step multiplier’ to 6, in order to keep the same 

calculation time step as before for the Rainfall-Runoff module 

• Export the ‘Lateral Inflows’ item from the HD parameters file, in the ‘Add. Output’ tab 

• Define a file name for the RR result file, in the results tab. 

After running the simulation, explore the additional output file containing ‘Lateral Inflows’ 

to see where runoff has been introduced in the river. 

 

Also compare the new Rainfall-Runoff result file with the previous one, obtained without 

the HD simulation. Do we get the same results as before? Why? 

 

New results are now wrong as they differ from the previous RR results which were 

calibrated on observed data. Try to improve the results from coupled simulation by using 

a hotstart for the Rainfall-Runoff module. 

 



Setting Up a NAM Model  

 15 

2.6.2 Decoupled RR and HD simulations 

We have seen how to run Hydrodynamic and Rainfall-Runoff simulations simultaneously, 

but most of the time it is sufficient to run them in decoupled mode. That means that both 

simulations are made separately. In that case Rainfall-Runoff simulation must be made 

first, in order to later provide input data to the Hydrodynamic simulation. 

 

To run a Hydrodynamic simulation in this decoupled mode, first deactivate the ‘Rainfall-

Runoff’ module in the Models tab of the simulation file. The path to the Rainfall-Runoff 

simulation file still appears in the Input tab, but is now greyed out, so this file won’t be 

used during the simulation. 

 

In order to define runoff input data into the Hydrodynamic simulation, simply browse to a 

Rainfall-Runoff result file, in the ‘RR Results’ field of the Input tab. You can for example 

use the result file from the previous simulation. 

 

 
 

Change the name of the result file, and launch the simulation. Check that you get the 

same results as with the simultaneous simulations. 
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3 Setting Up a UHM Model 

3.1 Model using SCS formulations 

3.1.1 Getting started 

We will now create a new model from the beginning. You can hence create a new project. 

 

Then create a new simulation file, and in the Models tab, only select ‘Rainfall-Runoff’. 

Also create a Rainfall-Runoff parameter file, and link it to the simulation file after having 

saved it. 

 

3.1.2 Initial settings 

We will now create a simple UHM model using SCS formulations. 

 

Start by creating a new catchment in the Rainfall-Runoff parameter file. As before, name it 

Sesupe and set its area to 8 750 km². Don’t forget to change the model type to ‘UHM’. 

 

In the UHM tab, set the baseflow value to 45 m
3
/s. Select the ‘SCS dimensionless’ 

formula in the ‘Hydrograph’ frame, and ‘SCS method’ in the ‘Elargement and Loss Model’ 

frame. 

 

In the latter frame, set the Curve Number to 71, which can represent a catchment mainly 

constituted of meadows with slow infiltration rate. 

 

The Antecedent Moisture Conditions (AMC) parameter may have one of the following 

values: 

• 1 for dry conditions, close to wilting point 

• 2 for normal (average) conditions 

• 3 for wet conditions close to saturation. 

For the current case, set the AMC to 2. 

 

Calculate lag time from Curve Number method, using a 50 km length and 5% slope. 

 

Now that the UHM properties have been defined, it is necessary to define the rainfall input 

data in the Timeseries tab. For this exercise, use the weighted time series named 

Rainfall_UHM.dfs0. 

 

Before running the simulation, make the following changes to the simulation file: 

• Set the simulation time step to 2 hours 

• Set a relevant simulation period by pressing ‘Apply default’ 

• Define a result file name. 

After running the simulation, open the result file in MIKE View and compare the runoff 

results to rainfall data. 

 

3.1.3 Modified settings 

Now we will investigate the effect of the AMC value on the results. Change this value to 3, 

representing almost saturated conditions, and re-run the simulation. Also change the 
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Curve Number to 86, according to the new AMC value (refer to table of Correlation 

between Curve Numbers and AMC values in MIKE 11 reference manual). 

 

Compare the new results to the previous ones. Again, add the rainfall data to the plot for a 

better understanding. 

 

3.2 Additional tasks, if time permits 

You can also try to use other loss and routing models, and refer to the reference manual 

for details. 

 
 


